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Introduction 

Copyist provides you with all the tools you need for creating a score from 
the ground up, or for fine tuning a score created in QuickScore Deluxe, 
Professional or Elite and saved as a Copyist file.  

Copyist treats notes, staves, clefs and other musical characters as graphical 
elements, and allows you the freedom to place elements on the page 
regardless of musical rules. This freedom allows you to easily create small 
excerpts to be included in work that is predominantly text, as well as very 
complex scores which are very difficult to create using software which must 
follow musical rules. 

The placement and editing of objects such as staves, clefs, time signatures, 
key signatures, notes and note markings is accomplished with both mouse 
operations and with the use of an extensive command key system.  
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Getting Started 

System Requirements 
Copyist requires a Pentium 300 or faster Windows compatible computer to 
operate. Windows 95, 98, NT, XP, Vista or greater is required. 

Installation 
To install Copyist, insert the Copyist CD into your CD drive. The 
installation will start automatically.  
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Moving Within a Score 

Moving the edit cursor within a score can be done either with the mouse or 
from the keyboard. 

Moving the Cursor 
The placement of symbols is determined by Copyist's edit cursor, a small 
rectangular box that can be moved anywhere on the screen using the mouse  
and the cursor arrow keys. 

When using the arrow tool, simply click the left mouse button anywhere on 
the screen to move the edit cursor with the mouse - the edit cursor will 
immediately jump to that position, with the center of the edit cursor aligned 
to the tip of the mouse pointer. 

When using any tool in the toolbar other than the arrow tool, click the right 
mouse button anywhere on the screen to move the edit cursor. 

To move the edit cursor with the cursor arrow keys, use Left Arrow, Right 
Arrow, Up Arrow and Down Arrow to move the edit cursor one space in 
the corresponding direction. CTRL+Left Arrow or CTRL+Right Arrow 
will move the edit cursor to the next or previous note in the current staff and 
CTRL+PAGE UP and CTRL+PAGE DOWN will move the edit cursor to 
the previous bar or the next bar. The HOME key moves the edit cursor to 
the previous staff and END moves it to the next staff. CTRL+HOME 
returns the edit cursor to the top of the page and CTRL+END moves it to 
the end of the page.  

Use PAGE UP and PAGE DOWN to scroll the display to view other 
portions of the page. You can also use the scroll bar at the right of the 
Copyist window to scroll the display up or down.  
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Selecting, Deleting and Inserting 
Pages 
Page commands are two-key sequences that are used to move to different 
pages within a score or to do page level editing to the score as a whole.  

 

   action keystrokes 

   go to next page pn 

   go to previous page pp 

   go to first page pf 

   go to last page pl 

   insert page pi 

   erase page pe 

 
You can also use tools in the Copyist tools window to select, delete or insert 
a page. 

The Page Select Tool is the third tool from the right in the Copyist tools 
window. This tool allows you to select a new page. In the center of this tool 
you see the number of the page in your score you are currently viewing. 
Clicking the page number itself brings up a small dialog box; type in the 
number of the page you wish to go to and Copyist will immediately jump to 
that page. Clicking on the right arrow will cause the next page to be brought 
up onscreen and clicking on the left arrow will cause the previous page to be 
brought up onscreen. 

The Insert Page Tool is the second tool from the right in the Copyist tools 
window. Click on this tool to insert a new page before the current page. 

The Delete Page Tool is the tool at the far right in the Copyist tools 
window. Click on this tool to delete the current page. 



 
 5 

Gauging Vertical and Horizontal 
Position 
Press the Insert key and the cursor will change to a cross that extends to the 
edges of Copyist's window. This allows you to see the exact vertical and 
horizontal alignment of symbols. Press the Insert key again and the cursor 
changes back to a box. 
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Entering Symbols 

Entering With the Mouse 
To enter symbols with the mouse, first select the type of object you want to 
enter in the object type palette, choose the arrow tool in the toolbar and 
enter the symbol onto the page by clicking and dragging the mouse. 

Object Type Palette 

 

The object type palette lets you select the type of object you are entering or 
editing. Click on a button in the object type palette to determine if you will 
be entering and editing text, lyrics or symbols. 

Text 

The button with the T in the object type palette is for text. When the T is 
selected from the object type palette, blocks of text can be entered or edited. 
To enter text, select the pencil tool from the toolbar and create a box by 
dragging the mouse. (Click and hold down the left mouse button, move the 
mouse down and to the left, and then release the left mouse button.) Now 
you can enter text into the box.  

You can also enter text by using the right mouse button with the arrow tool 
selected. 

The box can be moved by dragging with the right mouse, and resized by 
dragging the boundaries. Clicking outside an open text box closes it. 
Clicking on a closed text box opens it. 
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To change the font for the text in the current and subsequent text boxes 
choose the Text Font menu item under the Character menu and select a 
new font from the Font dialog. The text you've entered can be edited, erased 
and moved using the appropriate tools. 

Lyrics 

The button with the L in the object type palette is for lyrics. 

To enter lyrics, click on the L in the object type palette and then select the 
pencil from the toolbar. Click the mouse where you want to enter a lyric. 
The cursor will appear for you to enter your lyric. As you enter the lyric, it 
will automatically center on the position you have selected.  

You can also enter lyrics by using the right mouse button with the arrow 
tool selected. 

The lyric can be moved by dragging with the right mouse. To stop entering a 
lyric, click on a new position or else press the ESC key. 

To change the font for the lyric you are entering, choose Text Font from the 
Character menu and select a new font from the Font dialog. Lyrics can be 
edited, erased and moved using the appropriate tools. 

Symbols 

The button with the symbol (fff to start) in the object type palette is for 
symbols. The symbol button changes when a new symbol is selected and 
displays the last symbol that was selected. Click once on the symbol button 
and it becomes selected. At this point you can enter the symbol that is drawn 
on the button or edit any symbols that are in your score. Click on the symbol 
button again and a double palette of symbols drops down. There are ten 
symbol palettes to choose from, the last four of which are custom. Click on a 
symbol palette name to display the palette to the right of the names. Click 
on the symbol you want to enter and it will appear on the symbol button in 
the object type palette. Now this will be the symbol you can enter using the 
pencil tool.  

The Sym. 1, Sym. 2, Sym. 3 and Sym. 4 palettes can be changed by 
choosing Symbols 1, 2, 3 or 4 from the Character menu and selecting a 
new font from the Fonts dialog. You can use these palettes to enter symbols 
from alternate music fonts or fonts you have created yourself. 



The C. Sym. 1 and C. Sym. 2 palettes can be changed by selecting the 
Custom Symbols dialog from the Options menu. You can use these palettes 
to enter custom symbols, based on bitmap files. 

The C. Note. 1 and C. Note. 2 palettes can be changed by selecting the 
Custom Noteheads dialog from the Options menu. You can use these 
palettes to enter custom noteheads, based on bitmap files. 

The User palette contains the symbols you have create using the Symbol 
Editor. To select the Symbol Editor, choose User Symbols from the 
Character menu. 

Most of the palettes contain symbols that have a single shape that can’t be 
adjusted. We call these the nonadjustable symbols. However, the Staves, 
Bar Lines and Adjust palettes contain symbols whose shape can be 
adjusted. We call these the adjustable symbols.  

To enter nonadjustable symbols, choose the pencil tool from the toolbar and 
select the nonadjustable symbol you want to enter. You can enter the symbol 
anywhere on your page. Click the mouse where you want to enter a symbol. 
You can move the symbol on the page to where you want it by holding 
down the left button and moving the mouse until you have positioned the 
symbol where you want it on the page. When the symbol is positioned where 
you want it, lift the left mouse button and the symbol is placed onto the 
page.  

To enter adjustable symbols, choose the pencil tool from the toolbar and 
select the adjustable symbol you want to enter. Now click the left mouse 
button where you want the top-left edge of the symbol to go. Keep the 
mouse button down and drag the mouse to where you want the right-bottom 
edge of the symbol to go. Now release the mouse button. 

 

As you drag, the symbol will shrink and expand to follow the mouse. 
Release the mouse when you have positioned the symbol approximately 
where you want it. There will be three little diamonds at the left, right and 
center of the symbol. You use these control points to further shape and move 
the symbol. Click on a control point to select it and drag it around to shape 
or move the symbol. Alternatively you can move a control point around 
using the arrow keys. You can move between control points by using the 
TAB and the SHIFT+TAB keys as well as by clicking on them with the 
mouse. The middle control point is usually used for moving the symbol and 
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the outer control points for shaping the symbol. When you are finished 
shaping and positioning your symbol, click the right mouse button or press 
the ENTER key to enter it. If you don't want to enter your symbol, press the 
ESC key. 

When you are entering the 8va and 8vb symbols, you can control whether or 
not the 8va or 8vb text is shown and whether or not the finishing vertical 
line is displayed. The HOME key toggles whether the 8va is shown; the 
END key toggles whether the finishing vertical line is displayed. This is 
useful when octava markings extend over more than one line. 

When you are entering first and second endings you can change or eliminate 
the ending number. The ending number defaults to 1. for the first ending 
and 2. for the second ending. The numbers can be changed or eliminated by 
pressing the + (plus) and the - (minus) keys. 

You can put in and change the number for groupings by using the + (plus) 
and the - (minus) keys. Pressing + (plus) increments the number; pressing 
- (minus) decrements it. When you decrement past 1, the number disappears. 
You can change or eliminate the amount of space in the middle of the 
grouping by using PAGE UP and PAGE DOWN. 

PAGE UP and PAGE DOWN also work on crescendo and decrescendo 
symbols to change the angle of the symbol. 

Press F to flip a number of adjustable symbols. These include the crescendo 
and decrescendo symbols, the groupings, the endings and the octavas. 

Press L to horizontally level crescendos, decrescendos and groupings. 



Chord Symbol 
The symbol at the bottom left of the adjustable symbols palette is the chord 
symbol. When you enter a chord symbol, the Chord Name dialog appears 
for you to build the chord you want. 

 

Select the root of the chord in the box at the left of the dialog. The root can 
have a sharp, a flat or neither after it, depending on whether you select n, # 
or b beside the name for the root note. 

If your bass note isn't the root, you can indicate this. Check the Bass box and 
then choose the note you want for the bass. The bass can have a sharp, a flat 
or neither after it, depending on whether you select n, # or b beside the name 
for the bass note. 

Type in the type of chord you want in the Type box. If you want to type in a 
flat symbol, type B. If you want to type in a sharp symbol, type #. 

The Preview box will show you what your chord will look like. Note that 
numbers and accidentals appear in superscript. 
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Tempo Symbol 
The tempo symbol is to the right of the chord symbol at the bottom of the 
adjustable symbols palette. When you enter a tempo symbol, the Tempo 
Symbol dialog appears. Here you choose the beat value you want and the 
number for the tempo. The tempo symbol is previewed in the box at the 
right of the dialog. 

 

To select the beat value, click on the drop-down list box and select a beat 
value. Drag up and down with the mouse over the list box to scroll it. Click 
on the beat value you want. 

To select the tempo number, click on the spin buttons to move the number 
up and down or click on the number itself and change it by typing in a new 
number. 
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Tablature Chord Symbol 
The tablature chord symbol is to the right of the figured bass symbol in the 
bottom row of the adjustable symbols palette. When you enter a tablature 
chord symbol, the Tabulature Chords dialog appears. 

 

You make your tablature chord by selecting a chord from the list box at the 
top left of the dialog. You choose whether your tablature chord will have 4, 
5 or 6 strings from the string number dropdown list box. You choose a 
starting fret number from the drop-down list box under the string 
dropdown list box. You choose whether your tablature chord will have four 
or five frets by selecting 4 Frets or 5 Frets in the box below the fret number 
drop-down list box. 

You can set the circles on the tablature chord frets yourself by clicking on 
the preview grid wherever you want to put in a circle. You can only have 
one circle on any vertical line so entering a new circle on a vertical line will 
erase the old one. Circles entered at the nut will be open. Other circles will 
be closed. You can erase a circle by clicking on it. 
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Harp Pedals Diagram 
The harp pedals diagram symbol is the large symbol at the end of the 
second to last row in the adjustable symbols palette. When you enter a harp 
pedals diagram, the Harp Pedals dialog appears. 

 
Click in the preview area to change the placement of each pedal from the up, 
middle or low position. 

Graphic Symbols 
The G at the beginning of the last row in the adjustable symbols palette is 
for graphics. When you enter a graphic symbol, you first select the bitmap 
graphic file you want to place on the page using the Open File dialog that 
appears. Once the file has been selected, you can scale the dimensions of the 
graphic. To enter the graphic onto the page, press ENTER, or click outside 
the graphic image. To cancel the operation, press the ESCAPE key. 
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Figured Bass Symbol 
The figured bass symbol is to the right of the tablature chord symbol at the 
bottom of the adjustable symbols palette. When you enter a figured bass 
symbol, the Figured Bass dialog appears. 

 

Enter the figure you want by typing in the Figure box. Press ENTER to get 
to a new line. You can add accidentals at the cursor position by clicking on 
one of the accidental buttons at the left-hand side of the dialog or by using 
the key for each accidental (Press N for natural, # for sharp, etc.). Check 
the Parenthesis box if you want your figure to be enclosed in parentheses. 
The figure will appear in the Preview box the way it will be displayed on the 
page. 

You can also enter symbols by using the right mouse button with the arrow 
tool selected. 

Once you have properly adjusted and positioned the symbol, click the right 
mouse button or press the ENTER key to drop the symbol onto the page. 
You can press the ESCAPE key if you want to cancel the operation. 
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Entering from the Keyboard 

Single-Key Symbols 

There are a number of symbols which can be placed into a score by moving 
the edit cursor to the desired location and typing the single keystroke. These 
are shown in the following table: 

   
   symbol keystroke 

   sharp s 

   flat f 

   natural n 

   double sharp x 

   dot d 

   half note head h 

   whole note head w 

   quarter note head b 

   quarter note head to left of downstem l 

   half note head to left of downstem L  <Shift>l 

   quarter note head to right of upstem k 

   half note head to right of upstem K  <Shift>k 

   drum note head X  <Shift>x 

   closed diamond note head v 

   open diamond note head V  <Shift>v 

   ledger line z 

   staff S  <Shift>s 

   single staff line Z  <Shift>z 

   guitar staff G  <Shift>g 

   piano marking P  <Shift>p 
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   forte marking F <Shift>f 

   mezzo marking M  <Shift>m 

   number (for time sig) 0 .. 9 

   fingering number <Shift>1 .. 5 

Multi-Key Symbols 

The following symbols require multiple (two or more) keystrokes. As with 
the single-key symbols, they are entered at the cursor location. 

 

   symbol keystrokes 

   treble clef ct 

   bass clef cb 

   treble clef 8va cT 

   bass clef 8vb cB 

   alto clef ca 

   drum clef cd 

   damper pedal on D+  <Shift>d+ 

   damper pedal off D-  <Shift>d- 

   common time C+  <Shift>c+ 

   cut time C-  <Shift>c- 

   stems <direction><duration> 

   rests r<duration> 

   bar lines <F6><line style><number of staves> 

   turn ot 

   reverse turn oT 

   mordent om 

   mordent with slash oM 

   lower fermata of 
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   upper fermata oF 

   grace note og<direction> 

   copyright oC 

   open circle (harmonic) oh 

   accent oa 

   straight cross ox 

   heavy accent oA 

   tenuto oo 

   up martele ou 

   down martele od 

   up bow oU 

   down bow oD 

   repeat oR 

   measure rest or 

   grand pause oG 

   segno os 

   coda oc 

    first 10 user symbols A<1..0> 

    last 10 user symbols A< <Shift>1..<Shift>0 > 

 

Directions 
   up - 

   down + 

 

Durations 
   whole w 

   half 2 
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   quarter 4 

   eighth 8    

   sixteenth 1    

   thirty-second 3    

   sixty-fourth 6 

 

Line Styles 
   vertical line at left of cursor l 

   vertical line at right of cursor r 

   end line (at right of cursor) e 

   brace b 

   curly brace c 

   dotted line d 

   left repeat L 

   right repeat R 

 

Numbers of Staves 
   1 .. 9 

Clefs 
The treble, bass and drum clef keystroke commands may be executed with 
the cursor on any line of the staff, and Copyist will automatically center the 
symbol on the correct line. However, when entering these clefs from the 
symbols palette, you'll need to manually position them correctly on the staff. 

The alto clef symbol can be used to create other clefs as well, so the cursor 
must be properly centered when entering the alto clef from the keyboard. 
The less common tenor, soprano or mezzo-soprano clefs may be created by 
centering the cursor on the second line from the top, the bottom line, or the 
second line from the bottom, respectively and typing ca. Alternatively, you 
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can enter the alto clef symbol from the symbols palette to any position on the 
staff. 

Drum clefs placed with the keyboard command cd cannot be placed directly 
on a percussion staff (they will instead jump to the nearest five-line staff). 
To place a drum clef on a percussion staff, you must enter it from the 
symbols palette, or move it there after entering it with the keyboard 
command. 

Time Signature 
The Common and Cut-time signature abbreviations formed with the C+ and 
C- commands should be created with the cursor centered on the middle line. 
Alternatively, you can enter them from the symbols palette to any point on 
the staff. 

Stems 
When creating stems, the stem will go up from the cursor position if the - 
(minus) key is pressed, and down if + (plus) is pressed. This may seem to be 
backwards at first, but our experience has shown that this arrangement 
makes more sense when using the + and - keys on the numeric keypad, due 
to the placement of these keys. Stems for small note heads are somewhat 
shorter than those for normal note heads. 

Rests 
Rests are created from the keyboard by pressing r followed by a duration 
value. If entered from the keyboard, rests should be placed with the cursor 
centered on the middle line of the staff, except for whole note rests, which 
are created with the cursor centered on the second line of the staff. As usual, 
you can enter rests of any duration from the symbols palette to any point on 
the staff. 

Bar Lines 
Bar lines are created by pressing F6 followed by a style key, as listed in the 
table above, and the number of staves the bar line should encompass, 
starting with the current staff. Alternatively, you can select any bar line 
symbol from the bar lines symbols palette and manually place them 
anywhere on the staff and then adjust them to any length. The brace or curly 
brace is used at the beginning of each staff, the end line only at the end of a 
score or section, and the regular bar line at all other bar line locations. Bar 
lines are treated as part of the staff by the editing commands. 
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Editing Symbols 

You can use the arrow tool, the NSEW tool, the NS tool, the EW tool and 
the select tool in the toolbar to edit symbols. 

 

The Arrow Tool 
Use the arrow tool to select a single symbol or a group of symbol for 
editing. 

Selecting an Individual Symbol 

To edit an individual symbol, you have to first select the symbol by double-
clicking on it with the left mouse button. Copyist will find the single object 
whose beginning is closest to the mouse pointer. An Edit menu will appear, 
containing menu items that depend on the type of object selected. 

Selecting a Group of Symbols 

To select a group of symbols, drag the mouse over the symbols, (click and 
hold down the left mouse button and move the mouse until you have 
encompassed all the symbols and then release the mouse button). The 
selected symbols will be highlighted in reverse video and the Range Edit 
menu will appear. 
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Vertical Range Editing  

There are a number of special "vertical" edit commands which can be 
applied to a vertical range the width of the entire page. 

To define a vertical range, drag the cursor down and to the left while 
holding down the left mouse button. An area the full width of the page will 
be displayed in reverse video and the Vertical Edit menu will appear. 

This menu allows you to erase the defined area (normally used to bring 
systems or staves closer together) or to insert extra blank space between 
systems or staves to improve legibility or to make room for text or special 
symbols like slurs and dynamics. You can also cut, copy, or move the 
defined area.  

Edit Operations 

Cut 
Cut removes the selected symbol(s) from the score and places the data into 
the paste buffer, so that, if desired, it can then be pasted elsewhere in the 
score or into the pasteboard.  

Copy 
Copy copies the selected symbol(s) and places the data into the paste buffer 
without removing the data from the score. Copied symbols can then be 
pasted elsewhere in the score or into the pasteboard. 

Paste copied or cut symbols using Paste, available under the Edit menu or 
by pressing CTRL+V. Paste pastes the most recently cut or copied symbols 
at the cursor location. When you first paste a selection, the cursor changes to 
a cross. You can now move the pasted symbols anywhere on the page using 
the mouse or the arrow keys. For even finer control, hold down the CTRL 
key while pressing the cursor arrow keys - the selected symbols will move in 
the specified direction one screen pixel at a time. Once you have them 
positioned correctly, drop the symbols on the screen by pressing ENTER or 
clicking the right mouse button. You can cancel the Copy operation by 
pressing ESCAPE. 
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Move 
The Move option allows you to move any symbol or group of symbols to 
another position on the page. 

After you have selected the Move menu option, choose the type of symbol 
you want to move from the submenu.  

If you choose Align Lyrics from the submenu, any lyrics you have selected 
will be aligned horizontally to the same level as the left-most lyric selected.  

For all other types of symbols that you choose, the selected symbols will 
appear slightly distorted (xored) and the mouse pointer will change to a 
cross. You can now move the selected symbols to any position on the screen 
using the mouse or the cursor keys. For even finer control, hold down the 
CTRL key while pressing the cursor arrow keys - the selected symbols will 
move in the specified direction one screen pixel at a time. Once you have 
everything positioned correctly, drop the symbols on the screen by pressing 
ENTER or by clicking the right mouse button. You can cancel the Move 
operation by pressing ESCAPE. 

Adjust 

Adjust Note 

To adjust the placement of an individual note within a beamed grouping, 
double-click on the note to select it and then choose Adjust Note from the 
Edit menu. The mouse pointer will change to a cross. By holding down the 
left mouse button or by using the keyboard cursor arrow keys, you can drag 
the note to any new position. If you press and hold the CTRL key while 
using the left and right arrow keys, you can move the note left or right one 
pixel at a time. Press the right mouse button or press ENTER to complete 
the operation. To cancel the adjust operation at any time, press ESCAPE. 
Note that the Adjust Note function does not work when an individual note 
that is not within a beamed grouping is selected. 

Stem Height 

To adjust the stem height of an individual note (or even the stem height of a 
note within a beamed grouping), double-click on the note to select it and 
then choose Adjust Stem from the Edit menu. A small handle appears to 
the left of the note (indicating the stem height) and the mouse pointer 
changes to a cross. By holding down the left mouse button or using the 
keyboard up/down cursor arrow keys, you can now drag the stem to any new 
height. Press the right mouse button or press ENTER to complete the 
operation. To cancel the adjust operation at any time, press ESCAPE. 
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 To adjust one or more stems simultaneously, use the mouse to draw a range 
around the stem or stems you wish to adjust (be careful to include all note 
heads and stem symbols). From the Range Edit menu that appears, select 
Adjust. Select Upper Flags or Lower Flags, and the stem height handle 
will appear, as described in the previous paragraph. Follow the directions in 
the previous paragraph to adjust your stems. 

Adjust Symbol 

To adjust an adjustable symbol (that is, one from the adjustable symbols 
palette) double-click on it to select it and choose the Adjust option from the 
Edit menu.  

For most symbols, two or more handles will appear on the object and the 
mouse pointer will change to a cross. For most objects, the left handle 
affects the start of the object, the middle handle allows you to move the 
object and the right handle affects the end of the object. Click on one of the 
handles and hold down the left mouse button while dragging to adjust the 
selected object. Handles can also be selected by pressing the TAB key (next 
handle) or SHIFT+TAB (previous handle) and adjusted with the keyboard 
arrow cursor keys. If the middle handle is selected, pressing and holding 
down the CTRL key while using the left and right arrow keys allows you to 
move the object left or right one pixel at a time. When the selected 
adjustable symbol has been adjusted to your satisfaction, click the right 
mouse button or press ENTER to complete the operation, and the mouse 
pointer will return to its normal arrow shape. To cancel the adjust operation 
at any time, press ESCAPE. 

A number of symbols are edited by changing parameters in a dialog, which 
will appear when you select the symbol. These symbols are the Chord 
symbol, the Tablature Chord symbol, the Tempo symbol, the Harp Pedal 
symbol and the Figured Bass symbol. Editing these symbols works the 
same as entering them. For details on entering these symbols, see Entering 
Symbols, starting on page 7. 

You can also select an adjustable symbol to adjust by drawing a range 
around it with the mouse. From the Range Edit menu that appears, select 
Adjust and then select Symbol from the submenu. Now adjust your symbol 
as described in the preceding paragraph. 

Adjust Beam 

To adjust an individual beam, double-click on the top left edge of an upper 
or cross beam grouping or the bottom left edge of a lower beam grouping to 
select it. Now select Adjust Beams. The mouse pointer changes to a cross 
and two handles appear - one to the left of the beam and one to the right. The 
left handle adjusts the height of the beam, while the right handle adjusts the 
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beam angle. Select either, and press and hold down the left mouse button 
while dragging or use the keyboard cursor arrow keys to adjust the beam 
(the up/down cursor arrow keys always affect beam height while the 
left/right cursor arrow keys always affect beam angle).  

If you are adjusting an upper beam and you move the left handle below the 
note heads, the beam will change to a lower beam. Similarly, if you are 
adjusting a lower beam and you move the left handle above the note heads, 
the beam will change to an upper beam. Moving the left handle above or 
below the center point of a cross beam grouping will cause the beam to 
change to an upper or a lower beam, respectively.  

When the selected beam has been adjusted to your satisfaction, click the 
right mouse button or press ENTER to complete the operation, and the 
mouse pointer will return to its normal arrow shape. To cancel the adjust 
operation at any time, press ESCAPE. 

To adjust one or more beams simultaneously, use the mouse to draw a range 
around the beam or beams you wish to adjust (be careful to include all note 
heads and beam symbols). From the Range Edit menu that appears, select 
Adjust. The first three options in the submenu allow you to specify whether 
you want to adjust all beams, only upper beams, or only lower beams. Select 
one of these three, and the beam height and beam angle adjust handles 
appear, as described in the previous paragraph. Follow the directions in the 
previous paragraph to adjust your beams. 

Next 

The Next menu item allows you to select between two objects that are 
overlapping (for example, a note and a ledger line).  

Beam 
The Beam command in the Range Edit menu allows you to add beams to 
groups of notes. It also allows you to add stems to individual note heads or 
groups of note heads. 

First select the notes you want to beam by dragging the mouse over them. To 
do this, click and hold down the left mouse button and move the mouse until 
you have encompassed all the symbols, and then release the mouse button. 
The selected notes are highlighted in reverse video and an edit menu 
appears. Select Beam from the edit menu. Choose one of the durations from 
the submenu, and then either Beam Up or Beam Down from the next 
submenu.  

If you want more than one duration for your beamed grouping (for example 
a dotted eighth beamed with a sixteenth), choose Complex for the duration 
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and then Beam Up or Beam Down from the next submenu. Now for each 
note in your group, select the duration for that note from the dialog that 
appears. The Skip Note option in this dialog gives you the opportunity to 
leave selected notes within the group unbeamed. 

If you are beaming a single note head, a stem and flags are added to your 
note head according to the duration and direction you specified from the 
beaming submenus. 

Change Font 
If your selection includes text or lyrics, you can change the font for all text 
and lyrics selected by choosing Change Font. 

Eraser Tool 
The eraser tool will erase symbols anywhere on the page. Select the eraser 
tool and click on a symbol you want to erase. The symbol will disappear. 
When erasing a symbol, always click on the top-left corner of the symbol. 

NSEW Tool 
The NSEW tool is the one with the four arrows: one pointing north (up), 
one pointing south (down), one pointing east (right) and one pointing west 
(left). It moves a symbol around with complete freedom of movement. 
Select the NSEW tool by clicking on it and then click the left mouse button 
on a symbol that you want to move around. Keep the button down and drag 
the symbol to where you want to put it and then release the button. The score 
will redraw with the symbol in its new position. 

EW Tool 
The EW tool is the one with one arrow pointing east (right) and one arrow 
pointing west (left). It moves a symbol left or right. Select the EW tool by 
clicking on it and then click the left mouse button on a symbol you want to 
move forward or back. Keep the button down and drag the symbol to where 
you want to put it and then release the button. The score will redraw with the 
symbol at its new position. 
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NS Tool 
The NS tool is the one with one arrow pointing north (up) and one arrow 
pointing south (down). It moves a symbol up or down. Select the NS tool by 
clicking on it and then click the left mouse button on a symbol you want to 
move up or down. Keep the button down and drag the symbol until it is at 
the position you want, then release the button. The score will redraw with 
the symbol at its new position. 

Select Tool 
The select tool is the last tool in the toolbar. The select tool allows you to 
edit an adjustable symbol by simply clicking on it. Clicking on an 
adjustable symbol with the select tool is equivalent to double-clicking on the 
symbol with the arrow tool selected and choosing Adjust from the Edit 
menu. To properly select an adjustable symbol, make sure you click on the 
upper left-hand corner of the symbol.  

For most symbols, two or more handles will appear on the symbol and the 
mouse pointer will change to a cross. For most symbol, the left handle 
affects the start of the symbol, the middle handle allows you to move the 
symbol and the right handle affects the end of the symbol. Click on one of 
the handles and hold down the left mouse button while dragging to adjust 
the selected object. Handles can also be selected by pressing the TAB key 
(next handle) or SHIFT+TAB (previous handle) and adjusted with the 
keyboard arrow cursor keys. If the middle handle is selected, pressing and 
holding down the CTRL key while using the left and right arrow keys 
allows you to move the object left or right one pixel at a time. When the 
selected adjustable symbol has been adjusted to your satisfaction, click the 
right mouse button or press ENTER to complete the operation, and the 
mouse pointer will return to its normal arrow shape. To cancel the adjust 
operation at any time, press ESCAPE. 

A number of symbols are edited by changing parameters in a dialog, which 
will appear when you select the symbol. These symbols are the Chord 
symbol, the Tablature Chord symbol, the Tempo symbol, the Harp Pedals 
symbol, and the Figured Bass symbol. Editing these symbols works the 
same as entering them. For details on entering these symbols, see Entering 
Symbols, starting on page 7. 
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Deleting Symbols Using the 
Keyboard 
Symbols that are entered from the keyboard can be deleted by putting the 
cursor on the symbol (exactly where it was entered) and pressing DELETE 
and then the key combination that was used to enter the symbol. 
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Tools 

 

Toolbar 

 

You can use the arrow tool, the NSEW tool, the NS tool, the EW tool and 
the select tool in the toolbar to edit symbols. Use the pencil tool to enter 
symbols. See Editing Symbols, starting on page 20 for details on editing 
symbols, and Entering Symbols, starting on page 7 for details on entering 
symbols. 

Automatic Ledger Lines Tool 

 

This tool allows you to toggle the automatic ledger lines function on or off. 
When ledger lines are present in the box, the automatic function is on; any 
new notes you add above or below a staff will automatically have ledger 
lines added. To turn this function off, simply click on the box once - the 
ledger lines will disappear and any new notes you add above or below a staff 
will be placed without ledger lines. When you start Copyist, automatic 
ledger lines are set to on. 



Note Size Tool 

 

This tool allows you to toggle between normal and small-sized note heads, 
accidentals, beams, stems and clef symbols. When a full-sized note is 
displayed in the box (the default), all newly entered note heads, accidentals, 
beams, stems and clef symbols will be full size. Clicking on the tool causes a 
small note to be displayed, and all newly entered note heads, accidentals, 
beams, stems and clef symbols will be small-sized 

Object Type Palette 

 

The object type palette lets you select the type of object you are entering or 
editing. Click on a button in the object type palette to determine if you will 
be entering and editing text, lyrics or symbols. 

Page Select Tool 

 

In the center of this tool you see the number of the page in the score you are 
currently viewing. Click the page number itself to bring up a small dialog 
box; type in the number of the page you wish to go to and Copyist will 
immediately jump to that page. When you click on the right arrow the next 
page is brought up onscreen and when you click on the left arrow the 
previous page is brought up onscreen. 
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Insert Page Tool 

 

Click on this tool to insert a new page before the current page. 

Delete Page Tool 

 

Click on this tool to delete the current page. 
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Status Area 

The status area is at the bottom of the Copyist window. This area provides 
you with some visual indicators of the status of Copyist. 

Current Page  
The current page number and the maximum page are displayed in the area 
first from the left in the status area. 

Cursor Position 
The current X and Y cursor position are displayed in the area second from 
the left in the status area.  

Keyboard Command Keystrokes 
The third area from the left in the status area shows you the keys that you've 
pressed when entering symbols from the keyboard. When a keyboard 
command has been completed, "Ready" is displayed in the keystroke area. 

Menu Item Description 
In the area furthest to the right in the status area the description for the 
currently highlighted menu item is displayed. When no menu item is 
highlighted, "Ready" is displayed in this area. 
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Menus 

File Menu 

New 

Select New to create an empty, unnamed Copyist file. If you have edited the 
currently open file and haven't saved it, Copyist will ask you if you wish to 
save it before loading the new file. 

Open 

Select Open to open a file that already exists. This option brings up the 
Windows Open File dialog.  If you have edited the currently open file and 
haven't saved it, Copyist will ask you if you wish to save it before loading 
the new file. 

Save 

Choose Save to save your file. If you have not named your file yet, the Save 
As dialog appears and you will be able to give a name to your new file 
before you save it. 

Save As 

Choose Save As when you want to save your work to a file with a new 
name.  
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Export Picture 

Select Export Picture to save a page of a Copyist score in Windows 
Enhanced Metafile, BMP or TIFF format. Windows EMF is a vector format 
which can be scaled without losing resolution. BMP and TIFF are bitmap 
formats.  

From the submenu that appears, choose Enhanced Metafile, 300 dpi, 150 
dpi or 75 dpi.  

A file selection dialog box appears. If you choose 300 dpi, 150 dpi or 75 dpi, 
you can choose either BMP or TIFF in the Save File as Type list box. Bear 
in mind that the quality of the image and the size of the bitmap file generated 
increase with the resolution. Now enter the name of the file to which you 
wish to save your page and click on OK or press ENTER.   

You can now import your saved score page into another application. To do 
this, follow the directions in the documentation for this application.   

Print  

Select Print to print you Copyist file. 



Print Setup 

Select Print Setup to select a new printer or change aspects of your printing 
which depend on your printer. 

 

Your selected printer is shown at the top of the dialog. The print scaling 
amount is shown and can be selected in the Print Scaling edit box. The 
margins are set in the Left, Right, Top and Bottom Margin edit boxes. 
Select Inches or Centimeters at the bottom of the dialog for the display of 
margins. Click on Printer in the lower right-hand corner of the dialog to 
bring up the Windows Print Setup dialog. 

The Windows Print Setup dialog allows you to change aspects of your 
printing which depend on your printer. For more detailed information on the 
Windows Print Setup dialog, see your Windows User’s Guide. 
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Quit 

Select Quit to exit Copyist. Before exiting, you will be given a chance to 
save your work. Any changes not saved before quitting will be lost.  

Edit Menu 

Undo 

Undo  restores the last edit or entry.  

Redo 

Redo redoes the last undone edit or entry. 

Paste 

Paste pastes the most recently cut or copied symbols at the cursor location. 
When you first paste a selection, the cursor changes to a cross. At this point 
you can move the pasted symbols anywhere on the page using the mouse or 
the arrow keys. Once you have them positioned correctly, drop the symbols 
onto the screen by pressing ENTER or clicking the right mouse button. 
Press ESCAPE to cancel the paste operation. 

Select All 

Choose Select All to select all the symbols in your page for editing. 

View Menu 
Change the view from 100%, Page Width, Full Page or Print Preview. 
100% view displays music with a constant horizontal resolution of 640 
pixels. Page Width view displays music with a width equal to the window 
width. Full Page view displays the entire page on the screen. Print Preview 
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shows how your page will be printed on your selected printer. You cannot 
edit in Print Preview view. 

Character Menu 

Text Font 

Select the Text Font menu item to bring up the Windows Font dialog. If 
you are currently editing or entering text or a lyric, this will allow you to 
change the font for the current text or lyric. Once you change the text font 
using the Text Font menu item, any text or lyric entered will use the new text 
font.  

Chordname Font 

Select the Chordname Font menu item to change the font for all 
chordnames you have entered and that you will enter later on. 

Symbols 1 Font  

Symbols 2 Font 

Symbols 3 Font 

Symbols 4 Font 

Select the Symbols 1 to Symbols 4 menu items to change the font for the 
indicated symbol font. The symbol characters are the ones entered using the 
last four palettes in the symbols palettes. Once you change a symbols font 
using the indicated Symbol Font menu item, all symbol characters that 
you’ve entered as well as symbols that you will enter later on will display 
using the new symbol font.  
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User Symbols 

Select User Symbols to bring up the symbol editor.  

Each Copyist file can make use of up to twenty user-defined symbols (user 
symbols) unique to that file. User symbols are created in the symbol editor.  

In the symbol editor, screen or printer symbols are created by dragging the 
mouse within the smaller box (for screen symbols) or larger box (for printer 
symbols). If you start on a white pixel, the next pixels will be black as long 
as the mouse is down, and vice versa.  

Clicking on the left arrow button copies from the current screen symbol to 
the current printer symbol.  

Clicking on the right arrow button copies from the current printer symbol to 
the current screen symbol. Clicking on a number (1 to 20) will select that 
symbol.  

When you edit and save symbols, two special files are created with the same 
filename as the current file, and with the extensions of .FT1 and .FT3, for 
screen fonts and printer fonts, respectively. If you edit symbols in a file 
which has not yet been saved, Copyist will create the files UNTITLED.FT1 
and UNTITLED.FT3. 

The File menu for the symbol editor contains Read Symbol, which allows 
you to read a symbol from another symbol file (it reads the same symbol 
number as the current symbol, reading in both screen and printer symbols), 
Save, which saves the current symbol file, Revert, which restores the last 
saved version of the current symbol file (canceling all unsaved changes to all 
symbols in the current file!) and Quit, which exits the symbol editor. 

The Edit menu for the symbol editor contains Copy, Paste and Clear. Copy 
will copy the contents of the current printer or screen symbol to the 
clipboard, where it can be pasted back to another symbol, either to a printer 
symbol or to a screen symbol. Clear will clear both the screen and the 
printer versions of the current symbol. 

Options Menu 

Custom Symbols 
You can create up to 80 custom symbols. To create or modify a custom 
symbol, select the custom symbol number. Select the graphic file you 
want for the custom symbol, by clicking on the Browse button. An Open 



File dialog will appear, allowing you to select any bitmap graphic file to use 
for your custom symbol. The symbol will appear in the preview, which 
shows some staves, clefs and notes, to give you an idea of the relative size 
and proportions of your custom symbol. You can set the width and height 
for the symbol. Check Maintain Proportions to keep the same proportions 
when changing the width or height.  

  

To enter a custom symbol, choose it from the C. Sym. 1 or C. Sym..2 
symbols palette. The symbols numbered 1 to 40 will appear in the C. Sym. 1 
palette and the ones numbered from 41 to 80 will appear in the C. Sym. 2 
symbol palette. 

Custom Note Heads 
You can create up to 80 custom note heads. To create or modify a custom 
note head, select the custom note head number. Select the graphic file you 
want for the custom note head, by clicking on the Browse button. An Open 
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File dialog will appear, allowing you to select any bitmap graphic file to use 
for your custom note head. The note head will appear in the preview. It will 
automatically be scaled to the correct width of a note head.  

  

To enter a custom note head, choose it from the C. Note. 1 or C. Note.2 
symbols palette. The symbols numbered 1 to 40 will appear in the C. Note. 1 
palette and the ones numbered from 41 to 80 will appear in the C. Note. 2 
symbol palette. 

Hide Symbol Palettes 

Check Hide Symbol Palettes to keep the symbol palettes hidden after a 
symbol has been chosen. Uncheck Hide Symbol Palettes to allow the symbol 
palettes to remain visible after a symbol has been selected. This can be 
useful if you are changing symbols a lot. 
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Large Guitar Chords 

When Large Guitar Chords is selected, Copyist’s new style larger guitar 
chords are entered and displayed. For compatibility with previous versions 
of Copyist, the old, smaller style of Guitar Chords can also be entered and 
displayed by unchecking this option. When this option is unchecked, 
tablature chords with fewer than 6 strings are entered and displayed with 6 
strings. 

Pasteboard 
Select Pasteboard to open a pasteboard page which you can use to store and 
transfer any portion of a score. You can paste many different objects to the 
pasteboard without erasing the previously stored objects. You can edit in the 
pasteboard as in any other page. If you wish, you can save the pasteboard 
using the Save File menu command. To exit the pasteboard, select Exit 
Pasteboard. 

Help Menu 

Contents 

Select Contents to get help on Copyist. Navigate through Help by clicking 
on green text or by using the Help buttons or menus. For more information 
on Help, see your Windows User's Guide. 

Tool Tip Help 

Hold the mouse pointer over a Copyist control and a small caption will 
appear showing the name of the control. This feature is enabled by default, 
indicated by the check mark. To disable Tool Tips, click on Tool Tip Help to 
clear the check mark. 
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About 

Select About to bring up Copyist's about box, with credits for the program 
and the version number of your copy of Copyist. 
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How To 

 

Enter a staff 
Double click on the Symbol button in the object type palette in the Copyist 
Tools window to open the symbol palettes. Click on the Staves palette. The 
Staves palette will open, showing you all of Copyist's staff symbols.  

Select the kind of staff you want (either regular, single-line drum staff or 
four, five or six-line tablature staff) by clicking on it. The staff you choose 
appears on the Symbol button.  

Choose the pencil tool from the Toolbar. Now enter the staff symbol on 
your page by moving the mouse pointer to where you want to enter your 
staff and clicking the left mouse button. The staff will appear, with three 
adjustment handles which let you change the shape of the staff and move the 
staff before you drop it onto the page.  

If you want to move the start point of the staff, click the left mouse button on 
the left adjustment handle to select it and then drag the handle by clicking 
and holding down the left mouse button and moving the mouse, dragging the 
left adjustment handle and changing the start point of the staff. 

If you want to move the end point of the staff, click the left mouse button on 
the right adjustment handle to select it and then drag the handle by clicking 
and holding down the left mouse button and moving the mouse, dragging the 
right adjustment handle and changing the end point of the staff. 

If you want to move the staff up or down, click the left mouse button on the 
middle adjustment handle to select it and then drag the handle by clicking 
and holding down the left mouse button and moving the mouse, dragging the 
middle adjustment handle and moving the staff position up or down. 

Once you have properly adjusted and positioned the staff, click the right 
mouse button or press the ENTER key to drop the staff onto the page. You 
can press the ESCAPE key if you want to cancel the operation. 
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You can adjust the staff after you have entered it, by double clicking on the 
beginning of the staff (this is always the middle of the top line of the staff, at 
the far left edge of the page) and selecting Adjust from the edit menu that 
appears. 

Enter a bar line 
Double click on the Symbol button in the object type palette in the Copyist 
Tools window to open the symbol palettes. Click on the Bar Lines palette. 
The Bar Lines palette will open, showing you all of Copyist's bar lines.  

Select the kind of bar line you want by clicking on it. The bar line you 
choose appears on the Symbol button.  

Choose the pencil tool from the Toolbar. Now enter the bar line symbol on 
your page by moving the mouse pointer to where you want the top of your 
bar line to appear and then clicking and dragging the left mouse button 
downward to where you want the bottom of the bar line to appear. The bar 
line will appear, with three adjustment handles which let you change its 
shape and move it before you drop it onto the page.  

If you want to move the top of the bar line, click the left mouse button on the 
upper adjustment handle to select it and then drag the handle by clicking and 
holding down the left mouse button and moving the mouse, dragging the top 
adjustment handle and changing the top of the bar line. 

If you want to move the bottom of the bar line, click the left mouse button 
on the bottom adjustment handle to select it and then drag the handle by 
clicking and holding down the left mouse button and moving the mouse, 
dragging the bottom adjustment handle and changing the bottom of the bar 
line. 

If you want to move the bar line up, down, left or right, click the left mouse 
button the middle adjustment handle to select it and then drag the handle by 
clicking and holding down the left mouse button and moving the mouse, 
dragging the middle adjustment handle and moving the position of the bar 
line. 

Once you have properly adjusted and positioned the bar line, click the right 
mouse button or press the ENTER key to drop the bar line onto the page. 
You can press the ESCAPE key if you want to cancel the operation. 

You can adjust the bar line after you have entered it, by double clicking on 
the beginning of the bar line (this is always the top of the bar line) and 
selecting Adjust from the edit menu that appears. 
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Enter a clef 
Double click on the Symbol button in the object type palette in the Copyist 
Tools window to open the symbol palettes. Click on the Clefs palette. The 
Clefs palette will open, showing you all of Copyist's clefs.  

Select the kind of clef you want by clicking on it. The clef you choose 
appears on the Symbol button.  

Choose the pencil tool from the Toolbar. Now enter the clef symbol on your 
page. Do this by clicking and holding down the left mouse button. The clef 
will appear at the mouse cursor. As you continue to hold down left mouse 
button, you can move the mouse and the clef will follow, until you have 
positioned the clef where you want it on the page. When the clef is 
positioned where you want it, lift the left mouse button and the clef will be 
placed onto the page.  

If you want to undo the clef entry operation, select Undo from the Edit 
menu. 

You can move or edit the clef after you have entered it, by double clicking 
on the clef and selecting one of the edit operations from the edit menu that 
appears. 

Enter a time signature 
Double click on the Symbol button in the object type palette in the Copyist 
Tools window to open the symbol palettes. Click on the Misc. palette. The 
Miscellaneous symbols palette will open, showing you all of Copyist's time 
signature numbers.  

Select the first symbol of the time signature you want by clicking on it. (If 
you are entering a common time or cut time signature you only need one 
symbol. Otherwise choose the numerator first.) The symbol you choose 
appears on the Symbol button.  

Choose the pencil tool from the toolbar. Now enter the time signature 
symbol on your page. Do this by clicking and holding down the left mouse 
button. The time signature symbol will appear at the mouse cursor. As you 
continue to hold down the left mouse button, you can move the mouse and 
the symbol will follow, until you have positioned the symbol where you 
want it on the page. When the symbol is positioned where you want it, lift 
the left mouse button and the symbol will be placed onto the page.  
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If you need to enter the time signature denominator to complete your time 
signature, select it and enter it in its place as you did the numerator. 

You can also enter a time signature at the cursor position using keyboard 
commands. For example, a cut time symbol  is entered by pressing C then -, 
and a 3/4 time signature is entered by moving the cursor until it is centered 
on the second line of the staff, pressing 3, then moving the cursor down until 
it is centered on the fourth line of the staff and pressing 4. 

You can move or edit the time signature after you have entered it, either by 
double clicking on each time signature symbol and selecting one of the edit 
operations from the edit menu that appears, or by dragging the left mouse 
over the complete time signature, drawing a box around it, lifting up the left 
mouse button and then selecting one of the edit operations from the edit 
menu that appears. 

Enter a key signature 
Double click on the Symbol button in the object type palette in the Copyist 
Tools window to open the symbol palettes. Click on the Notes palette. The 
Notes symbols palette will open, showing you all of Copyist’s accidentals. 

If your key signature consists of flats, select the flat by clicking on it. If your 
key signature consists of sharps, click on the sharp. The symbol you choose 
appears on the Symbol button.  

Choose the pencil tool from the toolbar. Now enter each of the accidentals 
in the key signature on your page. Do this by clicking and holding down the 
left mouse button. The accidental will appear at the mouse cursor. As you 
continue to hold down the left mouse button, you can move the mouse and 
the accidental will follow, until you have positioned it where you want it on 
the page. When the accidental is positioned where you want it, lift the left 
mouse button and the accidental will be placed onto the page.  

Continue entering accidentals in this way until you have completed your key 
signature. 

You can also enter accidentals at the cursor position using keyboard 
commands. For example, a sharp is entered by pressing s, and a flat is 
entered by pressing f. 

You can move or edit the key signature after you have entered it, either by 
double clicking on each accidental in the key signature and selecting one of 
the edit operations from the edit menu that appears, or by dragging the left 
mouse over the complete key signature, drawing a box around it, lifting up 
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the left mouse button and then selecting one of the edit operations from the 
edit menu that appears. 

Enter note heads 
Double click on the Symbol button in the object type palette in the Copyist 
Tools window to open the symbol palettes. Click on the Notes palette. The 
Notes symbols palette will open, showing you all of Copyist's note heads. 

Select the note head you want by clicking on it. The note head you choose 
appears on the Symbol button.  

Now enter the note head symbol on your page. Do this clicking and holding 
down the left mouse button. The note head will appear at the mouse cursor. 
As you continue to hold down the left mouse button, you can move the 
mouse and the note head will follow, until you have positioned it where you 
want it on the page. When the note head is positioned where you want it, lift 
the left mouse button and the note head will be placed onto the page.  

You can also enter note heads at the cursor position using keyboard 
commands. For example, a closed black note head is entered by pressing b, 
and a half note head is entered by pressing h. 

You can move or edit the note head after you have entered it, by double 
clicking on the note head and selecting one of the edit operations from the 
edit menu that appears. 

   Without ledger lines 

To enter notes above or below the staff without ledger lines, click once on 
the automatic ledger lines tool in the Copyist toolbar (the second button 
from the left). The ledger lines on the button will disappear. Now notes 
entered above or below the staff will appear without ledger lines. 

To enter notes above or below the staff with ledger lines, click on the button 
again so that the ledger lines are visible on the button. Now notes entered 
above or below the staff will appear with ledger lines. 

   Small-sized notes 

To enter small-sized notes, click once on the note size tool in the Copyist 
toolbar (the third button from the left). The note on the button will change to 
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a small-sized note. Now notes and accidentals will be entered at small size. 
To change back to normal-sized notes, click on the note size tool again so 
that the note changes to a normal-sized note. Now notes and accidentals will 
be entered at normal size. 

Beam a group of notes 
Choose the arrow tool from the toolbar. Select the notes you want to beam 
by dragging the mouse over them. Do this by clicking and holding down the 
left mouse button and moving the mouse until you have encompassed all the 
symbols, and then releasing the mouse button. The selected notes are 
highlighted in reverse video and an edit menu appears. Select Beam from 
the edit menu. Choose one of the durations from the submenu, and then 
either Beam Up or Beam Down from the next submenu.  

If you want more than one duration for your beamed grouping (for example 
a dotted eighth beamed with a sixteenth), choose Complex for the duration 
and then Beam Up or Beam Down from the next submenu. Now for each 
note in your group, select the duration for that note from the dialog that 
appears. The Skip Note option in this dialog gives you the opportunity to 
leave selected notes within the group unbeamed. 

If you are beaming a single note head, a stem and flags are added to your 
note head according to the duration and direction you specified from the 
beaming submenus. 

   Crossed beaming 

To create crossed beaming, first beam your group of notes as you would 
normally, creating a beamed group with beams either up or down.  

Now double click on the left edge of the beam group and select Adjust 
Beams from the edit menu that appears. Two handles will appear. Drag the 
beam up or down by dragging the left handle up or down until the beam is 
where you want it.  Drag the right handle and the angle of the beam will 
change accordingly. When you have positioned the beam so that it is crossed 
as you want it, press ENTER or click the right mouse button to complete the 
operation. To cancel the adjust operation, press ESCAPE. 
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Beam a single note 
Stems are created by pressing + (plus) or - (minus) followed by a duration 
value. Possible duration values are 4, 8, 1, 3 and 6. When creating stems, the 
stem will go up from the cursor position if the - key is pressed, and down if 
+ is pressed. For example, to put an upward sixteenth note stem and flag on 
a notehead, put the cursor over the notehead, press - and then press 1. To put 
a downward eighth note stem and flag on a notehead, put the cursor over the 
note, press + and then 8. 

It is also possible to beam single notes the same way you beam a group of 
notes, that is by choosing the arrow tool in the toolbar and selecting the note 
to be beamed by dragging the mouse over it and then selecting Beam from 
the Edit menu.  

Enter a crescendo 
Double click on the Symbol button in the object type palette in the Copyist 
Tools window to open the symbol palettes. Click on the Adjust palette. The 
Adjustable symbols palette will open, showing you all of the adjustable 
symbols. 

Select the crescendo symbol. The crescendo now appears on the Symbol 
button.  

Select the pencil tool from the toolbar. Enter the crescendo symbol on your 
page by moving the mouse pointer to where you want the left edge of your 
crescendo to appear and then holding down the left mouse button and 
dragging the mouse to the right. The crescendo will appear, with three 
adjustment handles which let you change its shape and move it before you 
drop it onto the page.  

If you want to move the start of the crescendo, click the left mouse button on 
the left adjustment handle to select it and then drag the handle by clicking 
and holding down the left mouse button and moving the mouse, dragging the 
handle and moving the start of the crescendo. 

If you want to move the end of the crescendo, click the left mouse button on 
the right adjustment handle to select it and then drag the handle by clicking 
and holding down the left mouse button and moving the mouse, dragging the 
handle and changing the end of the crescendo. 

If you want to move the crescendo up, down, left or right, click the left 
mouse button on the middle adjustment handle to select it and then drag the 
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handle by clicking and holding down the left mouse button and moving the 
mouse, dragging the handle and moving the position of the crescendo. 

Once you have properly adjusted and positioned the crescendo, click the 
right mouse button or press the ENTER key to drop the crescendo on the 
page. You can press the ESCAPE key if you want to cancel the operation. 

You can adjust the crescendo after you have entered it, by double clicking 
on the beginning of the crescendo and selecting Adjust from the edit menu 
that appears. 

Enter a slur 
Double click on the Symbol button in the object type palette in the Copyist 
Tools window to open the symbol palettes. Click on the Adjust palette. The 
adjustable symbols palette will open, showing you all of Copyist's adjustable 
symbols. 

Select the slur symbol (immediately to the right of the decrescendo). The 
slur now appears on the Symbol button.  

Select the pencil tool from the toolbar. Enter the slur on your page by 
moving the mouse pointer to where you want the beginning of your slur to 
appear and then holding down the left mouse button and dragging the mouse 
to the right. The slur will appear, with four adjustment handles which let you 
change its shape and move it before you drop it onto the page.  

If you want to move the start of the slur, click the left mouse button on the 
left adjustment handle to select it and then drag the handle by clicking and 
holding down the left mouse button and moving the mouse, dragging the 
handle and moving the start of the slur. 

If you want to move the end of the slur, click the left mouse button on the 
right adjustment handle to select it and then drag the handle by clicking and 
holding down the left mouse button and moving the mouse, dragging the 
handle and changing the end of the slur. 

If you want to change the shape of the slur, click the left mouse button on 
one of the middle adjustment handles to select it and then drag the handle by 
clicking and holding down the left mouse button and moving the mouse, 
dragging the handle and changing the shape of the slur. 

Once you have properly adjusted and positioned the slur, click the right 
mouse button or press the ENTER key to drop the slur on the page. You can 
press the ESCAPE key if you want to cancel the operation. 
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You can adjust the slur after you have entered it, by double clicking on the 
beginning of the slur and selecting Adjust from the edit menu that appears. 

Enter a guitar chord symbol 
There are two ways to enter a guitar chord symbol.  

A simple way to enter a standard guitar chord symbol is to select the 
tablature chord symbol containing open and closed string marks from the 
Adjustable Symbols palette.  

Double click on the Symbol button in the object type palette in the Copyist 
Tools window to open the symbol palettes. Click on the Adjust palette. The 
adjustable symbols palette will open, showing you all of Copyist's adjustable 
symbols. 

Select the tablature chord symbol containing open and closed string marks. 
The tablature chord symbol now appears on the Symbol button.  

Select the pencil tool from the toolbar and click the left mouse button where 
you want to enter the tablature chord. The Tablature Chords dialog 
appears.  

You make your guitar chord by selecting a chord from the list box at the top 
left of the dialog. You choose a starting fret number from the drop-down list 
box under the chord list box. You can set the circles on the guitar chord frets 
yourself by clicking on the preview grid wherever you want to put in a 
circle. You can only have one circle on any vertical line so entering a new 
circle on a vertical line will erase the old one. Circles entered at the nut will 
be open. Other circles will be closed. You can erase a circle by clicking on 
it. 

The other way is to do everything by hand and is only recommended if your 
tablature symbol is not a standard size. 

Double click on the Symbol button in the object type palette in the Copyist 
Tools window to open the symbol palettes. Click on the Adjust palette. The 
adjustable symbols palette will open, showing you all of Copyist's adjustable 
symbols. 

Select the empty tablature grid symbol. The tablature grid symbol now 
appears on the Symbol button.  

Select the pencil tool from the toolbar. Enter the tablature grid symbol on 
your page by moving the mouse pointer to where you want the beginning of 
your tab to appear and dragging the left mouse button to the right. The 
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tablature grid will appear, with three adjustment handles which let you 
change its shape and move it before you drop it onto the page.  

If you want to move the start of the tablature grid, click the left mouse 
button on the left adjustment handle to select it and then drag the handle by 
clicking and holding down the left mouse button and moving the mouse, 
dragging the handle and moving the start of the tablature grid. 

If you want to move the end of the tablature grid, click the left mouse button 
on the right adjustment handle to select it and then drag the handle by 
clicking and holding down the left mouse button and moving the mouse, 
dragging the handle and changing the end of the tablature grid. 

If you want to move the tablature grid, click the left mouse button on the 
middle adjustment handle to select it and then drag the handle by clicking 
and holding down the left mouse button and moving the mouse, dragging the 
handle and moving the tablature grid. 

Once you have properly adjusted and positioned the tablature grid, click the 
right mouse button or press the ENTER key to drop the tablature grid on the 
page. You can press the ESCAPE key if you want to cancel the operation. 

You can adjust the tablature grid after you have entered it, by double 
clicking on the beginning of the tablature grid and selecting Adjust from the 
edit menu that appears. 

Now you can enter the open string and closed string symbols (open and 
closed circles). These symbols are found in the Articulation Marks Symbols 
palette, and they can also be entered by pressing , (comma) for the open 
circle or . (period) for the closed circle. 

Create User Symbols 
In this example we'll create User Symbol number 6. 

First select the symbol editor by selecting User Symbols from the 
Character menu. 

Click on number 6 in the grid of numbers at the bottom left of the symbol 
editor. The number 6 is highlighted. We'll create a symbol consisting of a 
simple rectangular box.  

In the symbol editor, screen or printer symbols are created by dragging the 
mouse within the smaller box (for what you see on the screen) or larger box 
(for what will print on the printer). If you start on a white pixel, the next 
pixels will be black as long as the mouse is down, and vice versa.  
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Create a rectangular box in the screen box by dragging the mouse around the 
edge of the box until a black border has been created. Now we'll transfer the 
symbol to the printer box by clicking on the right arrow button. 

Save the work you've done by selecting Save from the File menu. Quit the 
symbol editor by selecting Quit from the File menu. 

Enter User Symbols  
Before entering User Symbols, see How to Create User Symbols. 

To enter User Symbol number 6, for example, move the edit cursor to where 
you want the User Symbol to appear and type A then 6. To enter User 
Symbol number 16, move the edit cursor to where you want the User 
Symbol to appear and type A then SHIFT+6. User Symbol number 16 will 
appear.  

You can also enter a user symbol by selecting the user symbol you want 
from the User Symbols symbol palette and entering the symbol with the 
pencil tool. 

Enter text 
First, select the T button in the Object Type palette. Choose the pencil tool 
from the toolbar. Now click the left mouse button where you want the text to 
start, hold down the left mouse button and drag to create a box. Lift the left 
mouse button. You can now enter text into the box you have created.  

You select the font for the text you are entering by selecting Text Font from 
the Character menu and choosing a font. 

You change the size and shape of the text box you are entering by dragging 
one of the edges of the box. The cursor changes shape when you are in 
position to drag one of the edges.  

You move the box by dragging the box with the right mouse button.  

When you have finished entering your text, click the left mouse button 
outside the text box. 
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Edit text 
To edit text you have already entered, make sure the T button in the object 
type palette is selected and the pencil tool is selected in the toolbar. Click 
the left mouse button on the text you want to edit. The text box with the text 
editing cursor will appear, allowing you to edit the text. You can also edit 
text by clicking the right mouse button on the text with the arrow tool 
selected. 

You select the font for the text you are editing by selecting Text Font from 
the Character menu and choosing a font. 

You change the size and shape of the text box you are editing by dragging 
one of the edges of the box. The cursor changes shape when you are in 
position to drag one of the edges.  

You move the box by dragging the box with the right mouse button.  

When you have finished editing your text, click the left mouse button 
outside the text box. 

Enter Lyrics 
To enter lyrics, click on the L in the object type palette and then select the 
pencil from the toolbar. Click the left mouse button where you want to enter 
a lyric. The cursor will appear for you to enter your lyric. As you enter the 
lyric, it will automatically center on the position you have selected.  

The lyric can be moved by dragging with the right mouse. To stop entering a 
lyric, click on a new position or else press the ESC key. 

To change the font for the lyric you are entering, choose Text Font from the 
Character menu and select a new font from the Font dialog.  

Edit Lyrics 
To edit lyrics you have already entered, make sure the L button in the Object 
Type palette is selected and the pencil tool is selected in the toolbar. Click 
the left mouse button on the lyric you want to edit. You can also edit a lyic 
by clicking the right mouse button on the lyric with the arrow tool selected. 

You select the font for the lyric you are editing by selecting Text Font from 
the Character menu and choosing a font. 



 
54  

Move the lyric by dragging it with the right mouse button.  

When you have finished editing your lyric, click the left mouse button 
outside the lyric, or press ENTER. 

To align lyrics vertically, choose the arrow tool. Select the lyrics to be 
aligned by dragging over them with the mouse. (Click and hold down the 
left mouse button and move the mouse until you have encompassed all the 
lyrics to be aligned and then release the mouse button). The Range Edit 
menu will appear. Choose Move and then Align Lyrics from the submenu. 

Move a single symbol 
Choose the NSEW, the NS or the EW tool from the toolbar. Click on a 
symbol and drag it wherever you want on the page.  

You can also move a symbol as follows: Choose the arrow tool in the 
toolbar. Select the symbol you want to move by double-clicking on it. Select 
Move from the Edit menu that appears. Now you can drag the symbol to 
where you want it on the screen. (Drag the symbol by holding down the left 
mouse button and moving the mouse.) When the symbol is where you want 
it, place it by pressing the ENTER key or by pressing the right mouse 
button. Press the ESCAPE key to cancel the move operation. 

Move a group of symbols 
Choose the arrow tool in the toolbar. Select the symbols you want to move 
by dragging over them with the mouse (click the left mouse button and while 
holding it down, drag the mouse over the symbols you want to move, 
drawing a box around them, and then lift up the left mouse button).  

Select Move from the edit menu and then the type of symbols you want to 
move from the submenu that appears. Now you can drag these symbols to 
where you want them on the screen. (Drag the symbols by holding down the 
left mouse button and moving the mouse.)  

When the symbols are where you want them, place them by pressing the 
ENTER key or by pressing the right mouse button. If you want to cancel the 
move operation press the ESCAPE key. 
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Adjust beams 
Choose the arrow tool in the toolbar. Double click on the upper left edge of 
the beam group you wish to adjust and select Adjust Beams from the Edit 
menu that appears. Two handles will appear. Drag the beam up or down by 
dragging the left handle up or down until the beam is where you want it.  
Drag the right handle and the angle of the beam will change accordingly. 
When you have positioned the beam so that it is as you want it, press 
ENTER or click the right mouse button to complete the operation. To cancel 
the adjust operation, press ESCAPE. 

Move notes within a beamed group 
Choose the arrow tool in the toolbar. You can move notes within a beamed 
group, keeping the stems and beams intact, by double clicking on a note 
within the beamed group and selecting Adjust Note from the Edit menu.  

Now you can move the selected note within the beamed group with the 
keyboard cursor arrow keys or by holding down the left mouse button and 
dragging the note to a new position. You can select a new note within the 
beamed group by clicking on it with the left mouse button. 

When you have positioned the note(s) as you want them, press ENTER or 
click the right mouse button to complete the operation. To cancel the 
operation, press ESCAPE. 

Adjust an adjustable symbol 
Choose the arrow tool in the toolbar. Double click on the beginning of the 
symbol you want to adjust and select Adjust from the Edit menu.  

You can also select an adjustable symbol for editing by choosing the adjust 
tool in the toolbar and clicking on the beginning of the symbol you want to 
adjust. 

For most adjustable symbols, three adjustment handles appear which let you 
change the shape of the symbol and move it before you drop it onto the 
page. For the slur symbol, you have four handles. 

If you want to move the start of the symbol, click the left mouse button on 
the left adjustment handle to select it and then drag the handle by clicking 
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and holding down the left mouse button and moving the mouse, dragging the 
handle and moving the start of the symbol. 

If you want to move the end of the symbol, click the left mouse button on 
the right adjustment handle to select it and then drag the handle by clicking 
and holding down the left mouse button and moving the mouse, dragging the 
handle and changing the end of the symbol. 

If you want to move the symbol up, down, left or right, click the left mouse 
button on the middle adjustment handle to select it and then drag the handle 
by clicking and holding down the left mouse button and moving the mouse, 
dragging the handle and moving the position of the symbol. If you are 
adjusting a slur, dragging one of the middle handles will change the shape of 
the slur. 

Once you have properly adjusted and positioned the symbol, click the right 
mouse button or press the ENTER key to drop the symbol on the page. You 
can press the ESCAPE key if you want to cancel the operation. 

A number of symbols are edited by changing parameters in a dialog, which 
will appear when you select the symbol. These symbols are the Chord 
symbol, the Tablature Chord symbol, the Tempo symbol the Harp Pedals 
symbol, and the Figured Bass symbol. Editing these symbols works the 
same as entering them. For details on entering these symbols, see Entering 
Symbols, starting on page 7. 

Delete a symbol 
The simplest way to delete a symbol is to choose the eraser tool in the 
toolbar and click on the symbol (click on the upper left edge of the symbol.)  

Another way to delete a symbol is as follows: Choose the arrow tool in the 
toolbar. Select the symbol to be deleted by double clicking on it. Select Cut 
from the Edit menu and the symbol will disappear. (You can paste the 
deleted symbol to a new location now if you wish.)  

You can also select the symbol to be deleted by choosing the arrow tool, 
dragging a box around the symbol, selecting Cut from the Edit menu and 
then selecting an appropriate choice from the submenu. 

You can delete a symbol entered from the keyboard by positioning the 
cursor over the symbol exactly where it was entered and then pressing the 
DELETE key and entering the same keyboard command used to enter the 
symbol. 
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Use the pasteboard 
The pasteboard is used to hold temporarily any element or group of elements 
of a score you are working on. You can copy from any page in your score to 
the pasteboard, edit in the pasteboard and then copy from the pasteboard and 
paste back to any page in your score.  

Enter the pasteboard by selecting Pasteboard from the Copyist menu. Exit 
the pasteboard by selecting Exit Pasteboard. 

Undo mistakes 
Select Undo from the Edit menu to undo your last edit or entry. If you want 
to restore the edit that you undid, select Undo again. 

Go to a new page 
To go to a new page, click on the page select icon in the Copyist toolbar 
(third button from the right) and select the page you want. This will move 
you to that page. 

Create a new page 
To create a new page, click on the page select icon in the Copyist toolbar 
(third button from the right) and select the last page that can be selected. 
This will create a page one after the last page in your score and move you to 
that page. 

Insert a page 
To insert a page, click on the insert page icon in the Copyist toolbar (second 
button from the right). This will insert a new page before the current page 
and put you on that page. 
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Erase a page 
To erase a page, click on the erase page icon in the Copyist toolbar (first 
button on the right).  
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Service and Support 

Warranty 
This program and the associated documentation are Copyright 1998 by Sion 
Software Ltd. This program is licensed to be used on a single machine. It 
may not be copied without explicit written permission. If the program is 
transferred to another party, all backup copies must be transferred at the 
same time, or destroyed. This notice of copyright must be transferred if you 
transfer the program, and your license to use the program is terminated on 
transfer. 

The diskette on which the program is furnished is warranted for a period of 
ninety (90) days from the date of delivery. The program is not guaranteed to 
meet your requirements, and operation of the program is not guaranteed to 
be interruption or error free. In no event will Sion Software or its employees 
be liable for any damages, including any lost savings, lost profits, or other 
incidental or consequential damages arising out of the use of or inability to 
use this program, even if we have been advised of the possibility of 
damages. Sion Software shall not be responsible for any damages claimed by 
any other party, resulting from the use or attempted use of this program. All 
warranties implied are with Sion Software, not your local dealer. If problems 
arise, please call Sion Software directly. 

The various products mentioned in this manual are registered or pending 
trademarks of their respective manufacturers. 

Upgrades And Replacements 
Sion Software reserves the right to make improvements to the program 
without notice, and to make what Sion Software considers to be reasonable 
charges for updates and upgrades. 

There is a $19.95 charge for the replacement of program disks that become 
defective more than 90 days after the date of purchase. 
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When returning the disks for replacement or updates, please send them by 
UPS, Federal Express, Express Mail, or some other service that will allow 
you to trace the shipment. We’re sorry, but we cannot be responsible for 
packages sent via regular US mail. 

What To Do If Problems Arise 
If you have problems with Copyist that you are unable to resolve after a 
careful reading of the manual, Sion Software maintains both customer 
service and technical support lines. We are happy to help you with questions 
regarding Copyist, but due to the extraordinary variety of music related 
products available today and the number of possible system configurations, 
we cannot answer questions regarding hardware or software from other 
manufacturers. This includes questions on the basic operation of the IBM PC 
or other computers or musical instruments. 

Customer Service 
Customer Service is for owners who need replacement disks, upgrade or 
update information, or who wish to purchase software. The telephone line 
for customer service is the main number for Sion Software: (604) 222-2454. 
Customer service personnel are unable to help you with technical questions. 
If you have questions concerning technical matters, please phone the 
technical support line. 

Technical Support 
Technical support is for owners who are having difficulties with the 
installation or operation of Copyist. 

When calling Sion Software for technical support, there are a number of 
things that you can do to help us help you (which can also save you money 
on your phone bill!). Here is a checklist of things to have ready before 
calling: 

1. Your diskette registration number. 

2. Your manual. 

3. Your computer turned on and Copyist running. 
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4. Any information that can help us solve the problem, especially 
information about how to repeat your problem. If you cannot duplicate a 
problem, it is very difficult for a technician to figure out what is wrong! 

5. Information on your computer’s make, model, disk configuration, 
memory installed, sound source, monitor type, MIDI interface type if 
installed, and so on. 

6. Paper and pencil for taking notes. 

When you call us, we’ll walk you through the program and ask you 
questions about what happens. It is very important that you have the above 
materials at hand when calling. If you don’t have this ready, we will ask you 
to call back later with the required information. 

After you have completed the checklist, call us at (604) 222-2454 between 
10 AM and 2 PM Pacific Time, Monday through Friday. We’ll do 
everything we can to get you on the road to creating music with Copyist.  

You may also email technical support questions to: sionsoft@infoserve.net 
or take a look at our web site at: http://www.sionsoft.com for answers to 
your questions.  

Extensive efforts have been made to ensure that the information contained in 
this manual is accurate and that the program is error free. This is, however, 
an imperfect world. Should you discover any bugs, errors, or portions of the 
manual that are not clear, kindly send your comments to Sion Software so 
that they may be considered for inclusion in future revisions of Copyist. 
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